# Table of Contents

## Data Analysis
- Viewing a Test ........................................................................... 1
- Changing Templates ................................................................... 2
  - Template Descriptions .......................................................... 2
- Sorting a Column ........................................................................ 2
- Levels ......................................................................................... 3
- Drilling Down .............................................................................. 3
- Coloring ....................................................................................... 3
- Data Pivot ..................................................................................... 4
- Printing ......................................................................................... 4
- Charts
  - Charting Test Data .................................................................. 5
  - Labeling, Printing, and Saving a Chart ..................................... 6
- View All Students ......................................................................... 7
- Receiving a Sent View ................................................................. 7
- Reports ........................................................................................ 8

## Student Profile
- General Tab ................................................................................ 9
- Tests & Scores Tab ....................................................................... 10
- Show All Tests ............................................................................. 10
- Test Details ................................................................................ 10
- Forms Tab .................................................................................... 11
- Journal Tab .................................................................................. 11

## Monitor Groups/Lists
- Creating a Monitor List ............................................................... 12
- Managing Monitor Lists .............................................................. 13
- Viewing a Group or List ............................................................. 13

## Administer a Test
- Print Answer Sheets ................................................................... 15
- Scanning ...................................................................................... 16
- Enter Answers .............................................................................. 19
  - Enter Scores for Student Inventory Assessment ...................... 19
  - Online Testing ........................................................................ 20

## Teacher Tests
- Create a Test ............................................................................. 23
  - Teacher Administration Controls .......................................... 24
  - General Tab .............................................................................. 25
- Curriculum Tab .......................................................................... 26
- Questions Tab ............................................................................. 26
  - Question Types ....................................................................... 27
  - Associate TEKS ...................................................................... 29
  - Associate Process Standard ................................................... 30
  - Associate Question to a Resource ........................................... 30
- Edit a Question .......................................................................... 30
- Delete a Question ....................................................................... 31
- Make Corrections to a Key ......................................................... 31
- Alternating Lettering ................................................................. 31
- Advanced Tab ............................................................................ 32
- Rescore a Test ........................................................................... 32
- Clear Answer Documents ........................................................... 32

## Item Bank
- Creating Questions ................................................................... 33
- Submitting Questions ................................................................. 34
Data Analysis

Teachers can easily view TAKS and benchmark data on their students to help facilitate data analysis. This section will cover the basics of viewing data.

**VIEWING A TEST**

- Expand the class period, test type, subject, year, and grade level (by clicking on each folder) to view a test

**Note:** When selecting a grade level for a TAKS test, keep in mind that this is the grade the students were in when they took the test. You are only able to view students that you have in your current roster. So, you will select the TAKS test most recently took, not necessarily the grade level they are currently enrolled.

Once the test is selected, a list of students that took the test will appear. This should be the teacher's current roster students.

**Note:** If a student moved from another district, the TAKS scores will not appear for that student.
CHANGING TEMPLATES

There are four default templates that display different information about the test, such as Objective and SE information. District or campus administrators may create different templates that will appear in the list to provide more ways to analyze the test data.

- Click on the drop-down menu to choose a pre-created template. The template will be applied to the selected test.

**Note:** If the district or campus level personnel has shared a template with you, it will appear in the list of available templates.

Template Descriptions

Below is a list of information each default template will display when applying it to a test.

### Student Scores
- Raw score
- Scale score
- Vertical Scale Score
- Percent score
- Met Expectations
- Commended Performance

### TAKS Objectives
- Objectives - % Score
- Raw score
- Scale score
- Vertical Scale Score
- Percent score
- Met Expectations
- Commended Performance

### TEKS Student Expectations
- SE - % Score
- Raw score
- Scale score
- Vertical Scale Score
- Percent score
- Met Expectations
- Commended Performance

### Student Responses/Item Analysis
- Shows percent correct/incorrect for each question/objective/SE
- Raw score
- Scale score
- Vertical Scale Score
- Percent score
- Met Expectations
- Commended Performance

SORTING A COLUMN

Data can easily be sorted in ascending or descending order to help facilitate data analysis.

To sort a column in ascending order, click on the column name. To sort in descending order, click on the column name again.

***To sort within a sort, click on the first column to sort, and then click on the second column.
LEVELS
By changing the level, data can be viewed from different perspectives.

Toggle between the levels by clicking on each level.

DRILLING DOWN
Drilling down on data will display the results for a particular group or open the student’s profile.

To view results for students grouped together on a view, double click on the row title in the blue area of the screen. Drilling down on a student will display the student’s profile.

In the example to the right, double clicking on Economic Disadvantage will display the Economically Disadvantaged students in a teachers class that took this test.

***After drilling down, click the left green arrow to go “back” a level. (upper left corner of screen)

**Note:** If you drill down on a student’s name, it will take you to the student’s profile, which will be discussed in the section titled Student Profile.

COLORING
Test data can be color coded to make data stand out and view trends.

To view color coding, click the Color Coding icon in the upper left corner. The data will be color coded according to the following scale:

- 90-100 = green
- 80-89 = yellow
- 76-79 = orange
- <76 = red
- >2400 = green
- 2399-2201 = yellow
- 2200-2100 = orange
- <2100 = red
DATA PIVOT  Data pivoting allows data to be displayed vertically.

When a test is initially viewed, by default it will be displayed horizontally. Click the Compare Across Tests icon in the upper left corner to flip the column titles so that the data will be displayed vertically. To compare across groups again, click the Compare Across Groups icon and the view will change back.

**In the example on the right, the data was flipped on the Student Objective Breakdown template to view the data in a different way. Sometimes this view may be better for printing.**

PRINTING  Any data view can be exported to Excel or as a PDF.

Click **Print to Excel** to export the test information to Excel.

Click **Print to PDF** to export the test information as a PDF.
CHARTING

The charting feature allows you to save a chart as an image, print in color, and smart charts. Smart charting will automatically chart information as a bar or line graph when applicable and auto adjust the scale on the chart according to the values being graphed.

**Note:** Only group data can be graphed. Group data includes district, campus, and teacher levels.

Charting Test Data

- Select a test
- Switch to district, campus, or teacher level
- Click the **Charts** icon, located in the upper right corner of the screen (below the Log off button)
- Click on the number in the column to chart
Labeling, Printing, and Saving a Chart

To title, print, or save a chart, click the **View Large** button, located at the top of the chart.

1. Highlight the current tile and rename it.

2. Right click on the chart and choose to print or save the image.
VIEW ALL STUDENTS  Teachers can view all students at one time and by course and section.

To view all students for a test, expand All My Students, test type, subject, year, grade level, and test.

All the students who took the test will be displayed.

To view students by course and section, select the Course and Section level icon. The course and sections will be grouped so that the average scores for each section can be compared. To see the students for a section, drill down by double clicking on the teacher’s name and section.
**RECEIVING A SENT VIEW**

The sent view can be viewed by the teacher on the Analyze tab under *Received Views*. The teacher can print the view; however, they will not be able to edit or drill down on demographic data. The sent view is viewed exactly as it is shared unless they already have rights to view the students’ data.

---

**REPORTS**

There are pre-built reports located on the *Reports* Tab.

---

**Report Descriptions:**

Teacher Incorrect Responses Report – This report will help you to group students based on their responses to specific questions. Students that missed a certain question will be grouped by the desired parameter of either question number, objective, or student expectation.

Teacher Group Summary Report – In addition to standard objective information, this report will assist staff in analyzing objective mastery. By specifying your own mastery percentage, you can then view the percentage of students who attained that level on each objective numerically and visually. Additional summary data is provided as well.

Student Test Summary Report – This report will mass-print the test summary for each of the students that have taken the chosen assessment. This report will be similar to the individual test summary seen on the *Test and Scores* Tab in the student profile.
Student Profile

The student profile displays demographic information about the student, as well as other pertinent information discussed in this section.

Drill down to the student profile by double clicking on the student’s name from a data view.

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Local ID</th>
<th>Gender</th>
<th>Campus Name</th>
<th>Ethnicity</th>
<th>Row Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Litke, Ana</td>
<td>093425</td>
<td>Female</td>
<td>Blue Elementary</td>
<td>Hispanic</td>
<td>26</td>
</tr>
<tr>
<td>Looney, Luis</td>
<td>086670</td>
<td>Male</td>
<td>Blue Elementary</td>
<td>Hispanic</td>
<td>39</td>
</tr>
<tr>
<td>Mcdillan, Kal</td>
<td>089779</td>
<td>Female</td>
<td>Blue Elementary</td>
<td>Hispanic</td>
<td>41</td>
</tr>
</tbody>
</table>

OR

- Click on the Students tab on the left side of the screen
- Enter student’s name or ID#
- Click Search

**To clear the search criteria, click the Clear button.

GENERAL TAB

The General tab displays the student’s current schedule and whether or not the student is coded for any programs such as Special Ed, ESL, Economically Disadvantaged, etc.
The *Tests & Scores* Tab will contain the complete test history for the student. There are two views available when looking at a test from the student’s profile. *Show All Tests* will display all district assessments and TAKS tests for the student on one screen. *Test Details* will display a detailed data analysis on a specific test for a student.

### Show All Tests

There are two ways to access the complete test history:

- Drilling down on the student from a specific test and then clicking on *Show All Tests* in the upper-right corner
- Searching for the student from the *Students* Tab and clicking on the *Tests & Scores* Tab

**Printing from this screen will print a complete test history for the student.**

**To prevent a test type from being printed, collapse the section by clicking the triangle.**

### Test Details

There are two ways to access the test details:

- Drilling down on the student from a specific test
- Searching for the student from the *Students* tab, clicking the Tests tab, and double clicking on a specific test

Comparison Histogram: The Comparison Histogram is a distribution of Scale (or Percent) scores for the campus and district. The X axis represents the scale scores. The Y axis represents the percentage of students who fell within that group. The dot represents where the student fell.

Objective Performance Chart: Shows how the student performed on each objective, compared to the campus and district.

TAKS Objectives and Student Expectations: Shows the number of objectives/SE’s correct out of the total number of objectives/SE’s on the test.

Individual Question Response: Shows exactly what the student bubbled on the answer document, as well as the objective and SE for each question.

**Printing from this screen will print a detailed item analysis for the test.**
FORMS TAB  
Student forms are added on the *Forms* Tab. Forms are categorized into categories and will display the date and name of the staff member who added the form. Forms will remain with the student from year-to-year, unless deleted.

JOURNAL TAB  
The Journal Tab displays any journal actions added to the student. Teachers will only be able to view journal actions they actually add. Principals can see all journal actions added to the student.

- To add a journal action:
  - Click *Add Action Item*
  - Choose the action item
  - Enter the text for the journal action
  - Click *Add Item*
- To print journal actions, click the *Print* button
- To delete a journal action, click the *Delete* button

**Any journal action added will display the title, who added the action item, and the date.**
**Only principals and district admin can delete journal action items.**
Monitor Groups/Lists

Monitor Lists are typically created by teachers that need to be able to see students that are not in their current roster. For example, a teacher tutors students after school from another campus or from another class and needs to be able to see their profiles. By creating a monitor list and having the principal approve it, the teacher will be able to view all information on the students; profiles.

Monitor Groups are created by campus or district level administrators. When a monitor group of target students is created, the teachers who have students in the group will be able to automatically view the target group.

CREATING A MONITOR LIST

- Select Create a Monitor List in the lower left corner

- Follow the creation wizard to create a list
- On the third step, enter a name for the monitor list and click Next

- Search for a student by typing in the student’s last or first name, or ID#
- Press Enter or click Search
- Select the student from the list and click Add so that the name appears in the box on the right
- Repeat the process until all students are added and click Next and Finish

**The monitor list will be pending approval until an administrator approves it.**
MANAGING MONITOR LISTS  Monitor Lists can be created, edited, and deleted on the Students Tab.

- From the Students tab, select *Manage My Monitor Lists*
- Select the list and either edit or delete the list by using the buttons on the toolbar

VIEWING A GROUP OR LIST  Once a Monitor List is approved, the teacher can search for the student from the Students Tab or view the student’s profiles from the Analyze tab.

To view a monitor group or list, select *My Student Groups* from the Analyze Tab.

Select the student to see the student’s profile.
Administer a Test

To collect the results of an assessment, teachers can choose between a combination of several methods. Teachers have the option to print answer documents, enter the student answers manually, have students take the test online, or use response pads. Each method will be discussed in this section.

- Click **Test Available** on the **Analyze** Tab

- Select the test from the list of available tests

- Choose each class period to administer the test; click on the class again to de-select
- Choose from the options for test administration in the lower right corner of the window
Print Answer Sheets

- Click Print Answer Sheets located on the bottom of the screen
- Select Open to view the answer documents as a PDF and click the Printer icon to print
Scanning

Before answer documents can be scanned, the scanning application needs to be installed on the computer connected to the scanner. Download and install the Brother scanning application at www.schoolobjects.com/scannersetup.zip.

- Double click on the SchoolObjects scanner icon on the desktop

- Click Next

** If the Update Found screen appears, download the latest version of the scanner before moving to the next step.
Enter an email or username and password
Click Next

Place the test forms on the scanner
Click Next

Make sure the correct scanner is selected and click OK

Clicking OK will begin the scanning process. A status bar will complete for each document.

The scanning status will display the number of documents scanned, incorrectly scanned, possible errors found, and total documents scanned.

To view or fix possible errors, click the Response Editor button

OR

Click Next to upload results
On the Response Editor screen, a scanned image of the answer documents will be visible. They can be examined and answer responses fixed prior to uploading the results into Aware.

A list of scanned documents will appear on the right. All correct, incorrect, and possible errors will appear in this list.

Documents with Possible Errors Found have been recognized correctly as potential answer documents, but they have mistakes. There could be double-bubbled responses or questions with no response at all. But the student and test has been properly recognized.

Incorrectly Scanned documents have not been recognized as potential answer sheets by the scanner application. These documents are either damaged physically or have marks on the bottom code bars that prevent proper recognition.

To see only the answer documents with errors, select the option Only show documents with errors, located in the lower left corner of the window. Select the option Fit to screen to see the full answer document.

If an answer choice is color coded red, the student did not select an answer, or the answer choice was not bubbled dark enough. Upon viewing the answer document, an answer can be chosen for the student by selecting the answer from the drop-down menu for that question. If the answer choice is color coded yellow, the student bubbled in two answers. The system however will automatically select the largest and darkest bubble. This answer choice can also be changed prior to uploading. If an open-ended response is included on the test, the teacher can fill in the answer online after scanning. Those should NOT be scored in this process.

To delete an answer document, click the Delete button. This will clear a document from this scan. However, it will need to be corrected and re-scanned in order to be included in the final data set.

- Once all errors are fixed, click the Close button to return to the scanning wizard
- Click Next then Finish to upload answer documents

**Note**: Clicking on the Options button will list other options available when viewing the answer documents. A single answer document image or all the answer document images can be saved to a specific location.
Enter Answers

- In order for a teacher to enter answers on a district or campus level test, the test administrator must enable this administration type, otherwise the option will be available on any teacher created test
- Click Enter Answers located on the bottom of the screen
- Select the student to enter the answers
- Click the radio buttons to select the correct answers
- The teacher must click Save before going to the next student

Note: If a constructed response question is added to a test and the student’s written response on the answer document is scanned in, the teacher will be able to view the response online (as well as the scoring guide) before entering a score.

Enter Scores for a Student Inventory Assessment

When entering student inventory scores, make sure and set the overall status. The ranges will be displayed next to each task and whether or not the task is required. Make sure and click Save before moving to the next student or the scores will not be saved! Once the overall status is selected, the required scores are entered, and the Save button is selected, a green check mark will appear next to the student’s name. Student results can be viewed on the student’s profile on the Tests and Scores Tab or from the Analyze Tab.
Online Testing

- In order for a teacher to administer a district or campus level test online, the test administrator must enable online testing and choose whether the administrator or the teacher can Start and End testing. Check with the test administrator to see which options were selected. Online testing is always available for teacher tests. The student's password can be set by the system administrator so that each student has the same password, by the teacher for each individual student from the General Tab in the Student’s profile, or each student’s password may be imported by the system administrator. Check with your district’s system administrator for student password information.

- Click **Start Online Testing** at the bottom right of the screen
- Click to **Start** or **Stop** online testing

STUDENT DIRECTION

The students will need to login to eduphoria to take the test:

- Open Internet Explorer and enter the district’s eduphoria address and add /aware/onlinetesting to the address
- Login with Student ID number and password (the password is set by the system administrator or the teacher)
STUDENT DIRECTION

- Select the online test available and click **Next**

- Answer each question by selecting the correct answer and then clicking **Next**
- To navigate between questions, either click the **Previous** and **Next** buttons at the bottom of the screen
- Once all questions are answered click **Score Test**
Notes:

- Once the test has been scored, the student will not be able to access the test again.
- If the student needs to finish the test at a later time, the student can click Save Test and log back in as long as the teacher has Started online testing again.
- If the student clicks Score Test without answering all of the questions, the student will be prompted to answer the questions that were left blank or to Submit Test Without Filling In Answers.

Once all tests are submitted, choose the test under Test Available, select Start Online Testing, and click Stop. Students will no longer be able to take the test online unless the teacher Starts the test again. Results can be viewed on the Analyze Tab.
CREATE A TEST

Teachers have the ability to create their own assessments in Aware. These tests will not appear in the campus or district data in Aware. The data is only viewable for teacher data analysis.

Assessment Wizard  The Assessment Test Wizard will guide the teacher through the steps to create a test.

1. Click the Tests Tab
2. Click Create a New Test

3. In the New Test Wizard, select from the following options:
   - Create a quick test key – use this option when a test booklet will not be created
   - Create a new blank test – use this option when a test booklet will be printed and answer documents generated
   - Copy an existing test – use this option to copy an existing test

4. Click Next

5. Enter the Title and select a grade level

6. Click Next
7. Select the primary course associated with the test

*Note:* If multiple courses need to be associated with the test, additional courses can be selected in a later step.

8. Click **Next** and **Finish**

---

**Teacher Test Administration Controls**

**Save icon**

Click this icon when changes are made to the test

**Print icon**

- Print Test Booklet – if the actual test questions are entered, the test can be printed
- Print Test Key – once the key is created and connected to the correct TEKS, the key can be printed along with the scoring guide (if applicable)

**Delete Test icon**

This option should only be used if the test needs to be completely deleted. All results associated with the test will be deleted as well.

**Active**

Once an assessment is created it will default to **Active** which means that the test can be administered.

**Archived**

Once the test is completed and **ALL** documents have been scanned, the test should be archived. Archiving does not prevent the test from being analyzed, but no other answer documents can be scanned in for this test. Eduphoria will auto-archive all teacher tests during the summer before the next school year. If a test is ever reused, it should be copied from existing archived tests.

*Note:* Once a test is archived, it can be unarchived by selecting it from the archived section and selecting **Active**.
General Tab  The General Tab contains general information for the assessment.

Test Name
The test name can be changed before, during, or after the test administration.

Test Type
For teacher created assessments, the test type is set to Teacher Test and cannot be changed.

Subject Area
The subject area should already be selected based on the primary course chosen when the key was created.

Grade Level
The grade level will reflect the appropriate grade level that was chosen in the wizard.

Met Expectation Score
Enter the percentage of correct questions for the met expectations value of the assessment.

Commended Score
Enter the percentage of correct questions for the commended level of the assessment.

Instructions
Instructions for the test can be entered here. The instructions will appear on the second page of the test booklet.

Notes
This section is for personal notes that are only viewed by the teacher.
**Curriculum Tab**  The *Curriculum* Tab is used only when more than one course is associated with a test.

- Click **Add Course**
- Select additional courses to associate with the test
- Click **Add Course**

The courses will be available to choose from when associating TEKS to questions on the *Questions* Tab.

---

**Questions Tab**  This tab allows the teacher to create and format questions for the test builder. This also includes TEK SE alignment.

**Choose the Text Style of the Test Booklet**
- **A** – Elementary Booklet
- **A** – Secondary Booklet
- **m** – Modified Booklet
- **s** – Simple Booklet (Answer Key Only)

---

**Add Questions or Resources**
- Click **Add Question**
- Choose the type of question to add
**Question Types**

- **Selected Response** – multiple choice or multiple selection
  
  - The *Question* Tab is used to enter the content of the question and the answer choices as well as select the correct response. The answer choices can also be added, deleted, or reordered.

  - The *Options* Tab allows the teacher to select the format, layout, and other options for the question including question weight. Question weight also can be used to omit a question.

  **Note:** If the multiple selection option is chosen, the student's answer must match the multiple answers exactly. For example, if the answer is a and c, then the student must bubble in a and c to get the answer correct.

  - The *Standards and Resources* Tabs are consistent for all question types and will be explained in a different section.
• **Numerical Response** – griddable
  
o The *Question* Tab is used to enter the content of the question and correct numerical response.

  *Note:* The number limit for numerical responses is 9999.999 – (-)9999.999.

  o The *Options* Tab allows the teacher to select the number of decimal places for the numerical response along with other question options.

• **Constructed Response** - open-ended items that the teacher scores using a score range
  
o The *Question* Tab is used to enter the content of the question and the scoring guide.

  o The *Options* Tab allows the teacher to select the score range, the auto fail score, and other formatting options.
• **Resource** – A resource can be a reading passage or graphic that has multiple questions referencing the passage or graphic
  
  o The *Question* Tab is used to enter the title of the resource and the resource text and/or attach image(s).

  ![Question Tab](image1)

  o The *Options* Tab allows the teacher to format the layout of the resource.

  ![Options Tab](image2)

---

**Associate TEKS**

- Within the question editor, select the *Standards* Tab
- If the test is associated with multiple courses, select the correct course from the drop-down menu
- Choose the correct SE in the list and either double click to add the standard or click the *Select Standard* button
  
  ![Select Standard](image3)

  OR

  Search for the SE by typing a keyword into the text box, clicking the magnifying glass on the right, and choosing the SE. Then, either double click to add the standard or click the *Select Standard* button.
**Associate Process Standards**

- To further analyze a question, a process standard can be chosen by clicking the **Select New Process Standard** button.

**Associate a Question to a Resource**

- To associate a question to a resource, click the **Resources** Tab and select the check box next to the correct resource.

**Edit a Question**

- To edit the entire question, click the **Edit this question** button.

- You can also use the blue arrows to reorder questions.
Delete a Question

- Click the button and then the button in the question editor to delete a question.

Make Corrections to a Key

- Choose a different radio button next to the correct response.
- Click Finished.
- Repeat this process for each question.
- If any answer documents have already been scored, click the Rescore button on the Advanced Tab.

Alternating Lettering

By default, alternating lettering is turned on which means that the answer choices will be ABCD, FGHJ. To change the answer choices on a test to ABCD, ABCD, click the button.
The Advanced Tab is used to rescore a test, delete answer sheets, and clear all answer responses.

Rescore a Test

Rescoring can be used if:

- The met or commended level needs to be changed
- The key needs to be corrected
- Question weighting needs to be changed
- The question needs to be associated with a different SE or learning standard

Clear Answer Documents

There are two ways that answer documents can be cleared/deleted:

- **By student** – If a student’s answer document was accidentally scanned and the score needs to be removed, click the Delete Answer Sheet icon and select the student from the list and choose Remove. If a student’s answer document is removed, the document cannot be rescanned because the code at the bottom of the answer document becomes invalid. **Please use this feature with caution!**

- **All answer documents** – If the test needs to be changed (i.e. a question needs to be added or removed), all answer documents can be cleared so that the test can be changed. By clearing answer documents, all student scores associated with the test are deleted. Any answer documents printed prior to clearing the answer documents need to be reprinted because all answer documents previously printed become invalid. **Use caution when clearing all answer documents!**
Creating Questions  
Questions are accessed and added to the item bank on the Item Bank Tab. Security is set on all local and purchased item bank questions by district level staff members who manage the item bank. Other than the questions they create, teachers may only view and access local and purchased item bank questions that are made available to the teacher. To make changes to local or purchased item bank questions, they will first need to be added to a test, and then changes can be made for that test.

The item bank is organized by course and subdivided by student expectations. When selecting a course, notice that TAKS objectives show up in green text below the student expectations. This allows the teacher to easily view the tested objectives when creating questions.

To create a question:

- Select the course and student expectation

The item bank will be divided into the following categories: My Questions (the questions you create), Local Bank Questions (the questions published to the local bank), and purchased item banks.

- Click the Add Question button and select the type of question to add
- Enter the question text and answer choice on the Question Tab
- Choose the desired question options on the Options Tab
- Add any keyword search text on the Keywords Tab
- The Standards Tab displays the associated TEKS Student Expectation and TAKS Objective if it applies; select a new process standard if applicable
- Associate question to a Resource if applicable on the Resources Tab
- Click Finished to save changes

Note: Once a question is added to the item bank, the question is available for the teacher to add it to a test.

Submitting Questions

In order for a question to be used by other teachers or campus or district level staff, it will need to be submitted and published. Depending on how your district set up question submission, the question will either automatically be added to the local bank when published, or the question will first need to be approved by a data administrator or item bank administrator. Once the administrator approves it, security can be selected for the question that will allow the question to be used on district assessments, campus level assessments, and/or teacher tests.

To submit a question:
  - On the question editor, click the Publish button

The question status will display as Submitted. Once the question is approved, the status will display as Published.